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BRCC GUIDELINES FOR PREPARING AND SIZING DIGITAL IMAGE FILES FOR 
CLUB PDI COMPETITIONS  

The club’s Competition Rules describe the essential parameters for your PDI entries, or digital version 
used in conjunction with a Print competition. This is the version to be used for the 2022/23 season. 
This document does not form part of the rules but extracts the key elements and provides guidance 
as to how to comply with them and get the best quality from your prepared images.  

 

1 Club Competition Rules 2022-23 ....................................................................................... 2 

2 2022/23 Competition subject Definitions ......................................................................... 2 

3 2022/23 Competition Subject Categories .......................................................................... 2 

4 How to Submit an Image to the BRCC Competition web site ............................................ 4 

5 Preparing your images for competition ............................................................................. 5 

6 Photoshop Elements (Version 12) ..................................................................................... 5 

7 Photoshop (CC) .................................................................................................................. 6 

8 LightRoom (CC) .................................................................................................................. 7 

9 Affinity Photo ..................................................................................................................... 8 

10 iPhone using Snapseed to process the image ................................................................... 9 

  



BRCC Guidelines for preparing and sizing digital image files R Crocombe 
 

 2 

 
 

1 Club Competition Rules 2022-23 
 
Like most clubs BRCC uses club competition software DICENTRA to manage and run their 
Projected Digital Image Competitions.  These are requested for all single print competitions 
as well as the PDI competitions. 
 
To ensure your image is a) included and b) projected as you intended, the colour space, 
sizing, and naming needs to be correct. You can check that all this is correct prior to 
uploading by looking at the EXIF/Metadata for the image before submitting it.  
1.1. Digital images for PDI competitions must be a maximum of 1600px (pixels) wide by 1200px 

(pixels) tall including any digital borders or frames and be titled as described below. 

1.2. All images must be formatted in the sRGB colour space. 

1.3. The title of the image must be in the following format:  

Competition Subject Category; [space] IMAGE TITLE (in Capitals ); [space] Entrant’s name.jpg 
For example: PDI – Natural World; HUNGRY BEAR; Ann Author.jpg, or Print – Natural World; 
HUNGRY BEAR; Ann Author.jpg 
1.4. The Competition Subject Category must be taken from the list of Subject Categories being 

judged that session (see below for the 2022/2023 competition list and presentation dates) 

1.5. The images must be provided as files by submission through the on-line form on the club's 

website members' area.  See section 4 How to Send an Image to the BRCC Competition 

Website in section 4 below. 

1.6. Images must not carry an identifiable watermark such as a name or signature that could 

identify the photographer that may influence the decision of the judge. Images found to 

contain a watermark will be rejected automatically by the competition secretary. 

1.7. Images not meeting the above criteria will be rejected by the on-line form during the 

submission process  

 

2 2022/23 Competition subject Categories 
Please see BRCC Competition Subject Categories document for full details 
 

3 2022/23 Competition Subjects and Dates 
Date Competition Subject 1 Subject 2 

27/09/2022 1st PDI Competition Open  

11/10/2022 1st Print Competition -  Open  

01/11/2022 2nd PDI Competition -  Landscapes  People 

15/11/2022 2nd Print Competition -  Natural World  People 

06/12/2022 3rd PDI Competition -  Architecture Abstract/Experimental 

24/01/2023 3rd Print Competition -  Landscapes  Low Light 

28/02/2023 4th PDI Competition -  Natural World Low Light 

14/03/2023 4th Print Competition -  Architecture Abstract/Experimental 

04/04/2023 Open - Print and PDI 
competition 

Open  
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Please see the current BRCC programme for the dates for entry etc, and the current 
Snapshots for any last minute changes to the competitions, dates or submissions. 
Please note that the exact title to be used for titling your entry will be displayed on the 
website 'image upload' page. 
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4 How to Submit an Image to the BRCC Competition web site 
Log into the BRCC Member’s Admin page where you will be presented with a screen like 
that below. 

 
Go to the “Competition Entry Image Upload section  
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Follow the instructions posted at the bottom of the web page to upload your files. Details of 
how to prepare photos using different applications are show in subsequent sections of this 
document. 

4.1 Naming your images 
Your image files need to be accurately named as this name is used directly in the DiCentra 
competition software. To be certain of this you can copy elements of the name from the 
website file uploading page. 
 
As stated in the rules above the title of the image must be in the following format:  
Competition Subject Category; [space] IMAGE TITLE (in Capitals); [space] Entrant’s Name.jpg 
You can copy the Competition Subject Category directly from the web page 'Subject' 
column. Check that no spaces have been picked up at the beginning or end of your copying. 
You can copy your name from the 'You are logged in as' part of the web page. Again, check 
that no spare spaces have been picked up to the copying. 
This will ensure your entry's title will exactly match the data in the database when you 
submit your image. 
 

5 Preparing your images for competition 
Precise instructions vary according to the software you use and the version number. This 
section of the document contains some of the most popular examples to guide you. If you 
need more help please contact a member of the committee to get this guide amended. 
However, for most images you will need to: 

1. Re-size 
2. Change the colour space to sRGB 
3. Save the image as .jpg file 
4. Re-name the image file. 

 

6 Photoshop Elements (Version 12)  
In Photoshop Elements you must size your image before you save it. It is better to process all the 
adjustments to your image including cropping to get the aspect ratio you want for your image 
(horizontal vs vertical aspect). This is achieved by using the Crop tool in the toolbar to get the ratio 
you want for your image before final sizing so as to retain the highest quality in your Master image. 
Save it before final sizing.  
 

1. Go to Image>> Resize>> Image Size (Shift+Ctrl+I)  
2. Check ‘Constrain Proportions’ (which ensures your image will have the same proportions 

whatever size you choose to make it. 
3. Check Resample image’ and select the method you prefer. This will ensure that you get the 

best quality from the resizing algorithms -  See link below to Adobe’s guidance.  

4. FOR A LANDSCAPE FORMAT: check that the horizontal pixel dimension does not 
exceed 1600. If it does, reduce to 1600, then check that the vertical dimension does 
not exceed 1200. This should be automatic if you have chosen “Constrain 
proportions” in step 2 above. If 1200 pixels is exceeded, this may be an error as your 
cropping of the image for a landscape image cannot have the vertical height greater 
than 1200 unless the image is square or nearly square in which case it should be 
treated as a portrait image. 

5. FOR A PORTRAIT FORMAT: check that the vertical pixel dimension does not exceed 
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1200. If it does, reduce to 1200. (Note: in portrait format the horizontal dimension 
will by definition be less than the vertical, so cannot exceed 1200).  

6. To Change colour profile to sRGB:  Image->Convert Color Profile-> Convert to sRGB 
profile 

Now Save your image with a new name to match the competition you are entering, 
complete with semi-colons, to retain the high quality of your Master.  
Eg Competition Subject Category; [space] IMAGE TITLE (in Capitals); [space] Entrant’s 

name.jpg 
For instance:     PDI - Architecture; TOWER BRIDGE; Richard Lionheart 
 

See: https://helpx.adobe.com/photoshop-elements/using/resizing.html#main-
pars_heading_0  

 

7 Photoshop (CC)  
Using the “Export As” (File->Export->Export As…) option you can now resize, change the 
colour space (to sRGB) and save the imgae as a jpeg without having to change your master 
image. The screen capture below shows the options: 

 
For each image to be entered in a competition: 

1. Check that the export format is JPG 
2. Ensure the Quality it set to maximum (7) 
3. Check that the width is no greater than 1600px OR the height is no taller than 1200px 

(and don’t try to change the both!)  
4. Check ‘Resample Image’ and select the method you prefer or leave to default.  
5. FOR A LANDSCAPE FORMAT: check that the horizontal pixel dimension does not exceed 
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1600. If it does, reduce to 1600, then check that the vertical dimension does not exceed 
1200. This should be automatic.. If 1200 pixels is exceeded, this may be an error as your 
cropping of the image for a landscape image cannot have the vertical height greater 
than 1200 unless the image is square or nearly square in which case it should be treated 
as a portrait image. 

6. Please note that if your image is less than 1600/1200 pixel maximum sizes it will project 
on the screen as a correspondingly smaller image. 

7. FOR A PORTRAIT FORMAT: check that the vertical pixel dimension does not exceed 1200. 
If it does, reduce to 1200. (Note: in portrait format the horizontal dimension will by 
definition be less than the vertical, so cannot exceed 1200). 

8. Leave the Color Space set to sRGB and Embed the profile. 
9. Hit the Export button to decide where to save the file and with what name. 
10. In the following File location change the name of the file to comply with that of the 

competition eg Competition Subject Category; [space] IMAGE TITLE (in Capitals); [space] 
Entrant’s Name.jpg. 

11. For instance:     PDI - Architecture; TOWER BRIDGE; Richard Lionheart 
12. Hit Save to save the new file 
 

8 LightRoom (CC) 
In Lightroom, your image is sized as part of the final export process that will also create a 
jpeg file. Your master image is not affected by this process. Before you start the export 
process, please crop the image the way you want it to appear in the final projection. As a 
result of this crop do ensure that the image to be used has enough pixels by checking the 
Cropped item in the Metadata information panel on the right of the Library Tab. It must be 
at least 1600 pixels wide if a landscape or 1200 tall if a portrait, to ensure the images can be 
successfully projected. 
To Export your image (export = save your image as). 

 
 

1. Select the image to be exported on the filmstrip section at the bottom of the screen (in 
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the Library module) 
2. Change the Title of the image in the Title section of the RH panel to meet the naming 

requirements for the competition eg Competition Subject Category; [space] IMAGE TITLE 
(in Capitals); [space] Entrant’s name.jpg. For instance:     Architecture; TOWER BRIDGE; 
Richard Lionheart 

3. Select the image to be exported on the filmstrip section at the bottom of the screen (in 
the Library module) 

4. Click the export button at the bottom of the LH (Navigation) Panel to bring up the export 
dialogue screen. (Note Screen 1) 

5. In this export screen set the following parameters: 
 Export Location 

 Export to  -> Choose Folder Later (to enable you to select the folder in which to 
put the image later) 

 Add to catalogue ticked (ie add to this catalogue) 

 Existing files -> Ask what to do (in case you have already exported it) 
 

File Naming section of the export dialogue screen 

 Rename to “Filename as Title” in the drop down menu 

 Underneath it should say Example: Architecture; TOWER BRIDGE; Richard 
Lionheart (or whatever your Title is in Library) 

 
File Settings 

 Image Format -> JPEG, Quality = 100 

 Color Space -> sRGB 

 Limit file size not ticked (ie no limit to file size) 
 

Image Sizing  
Resize to fit -> Width & Height, “Don’t enlarge” not ticked –  
 

This will resize the photo to fit within the specified width and height, retaining the 
original aspect ratio. Specifying 1600 x 1200, for example, produces a 800 x 1200 
portrait photo or a 1600 x 1200 landscape photo, depending on the crop ratios chosen in 
develop. 
1600 x 1200 -> pixels, Resolution (N/A – has no effect if pixels have been chosen as the 
dimension) 
 

Output sharpening ->      Sharpen for  ->         Screen, Amount -> Low 
Metadata ->                      Include ->                   Copyright only 
Watermarking ->             No watermarking 
Post processing ->           as you wish 

 
6. Click on the Export button at the bottom to complete the action. Note that the process 

will ask you where you want to save the file. So, navigate to the folder where you store 
your competition images and click on Open to complete the action. 

 

9 Affinity Photo 
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1. Having saved your final edited version of the image 

2. In the default Library view (View->Studio->Library->Default) choose Convert to sRGB 
to convert to the correct colour space for competitions 

3. In File->Export -> Choose JPEG as the export format and in the Size box underneath, make 
sure the first (width) box is set to 1600 (for a landscape) or the second box (height) is set to 
1200 (for a Portrait image) and ensure that the padlock is set to constrain the proportions to 
maintain the aspect ratio. Entering one of these two fields will force the other one to reset 
when you click on it only if the padlock is closed. 

4. FOR A LANDSCAPE FORMAT: check that the first horizontal pixel dimension does not 
exceed 1600. If it does, reduce to 1600, then check that the vertical dimension does 
not exceed 1200. This should be automatic if you have chosen “Constrain 
proportions” in step 2 above. If 1200 pixels is exceeded, this may be an error as your 
cropping of the image for a landscape image cannot have the vertical height greater 
than 1200 unless the image is square or nearly square in which case it should be 
treated as a portrait image. 

5. FOR A PORTRAIT FORMAT: check that the vertical pixel dimension does not exceed 
1200. If it does, reduce to 1200. (Note: in portrait format the horizontal dimension 
will by definition be less than the vertical, so cannot exceed 1200). 

6. Preset should be set to JPEG (best quality). 

7. N.B. If your image is already is a JPG save “as a copy” to keep your master untouched 
rather than an export 

8. Choose Export from this screen and in the File Save dialogue rename the file to meet 
the competition requirements …  

9. Type in your competition File Name which must be compliant with the Club 
competition requirements – eg Competition Subject Category; [space] IMAGE TITLE 
(in Capitals); [space] Entrant’s name.jpg 
For instance:     PDI - Architecture; TOWER BRIDGE; Richard Lionheart 

10. Choose the location where you want the file saved 
11. Click OK. 

 

10 iPhone using Snapseed to process the image 
 
The assumption here is that you have taken your image on your iPhone (Android equivalent 
to come later). This picture will probably be in HEIC format (a new kind of jpeg) and will be 
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in the colour space P3 (as used by Apple everywhere): 
 

1. The key app to use on the iPhone is Snapseed in which you can first Crop to achieve 
your ideal image ratio 

2. Then use Rotate to straighten horizons 
3. Process as required using the tools and filters 
4. To resize the image down to 1600 x1200 use the App Image Size and choose pixel as 

the measuring choice (vs mm or cm) set the width to a maximum of 1600 px or the 
height to a maximum of 1200 px (depending on your image aspect ratio) 

5. To correctly rename this file (and save it as an sRGB jpeg (as required for the 
competition website):  

a. Download (bottom left) to Camera Roll – this will automatically save the file 
as an sRGB jpeg) 

b.  Select the file in Camera Roll and click on “Save to files” and click in the box 
to change the name to the BRCC competition format as described below, 
then save to Downloads 

6. With the file correctly sized, in sRGB and with the correct competition name stored 
in downloads in the iPhone, log into the BRCC website with your phone 

7. Browse through your images on the iPhone and upload to the website, the correct 
image. 

 
 
 
 
 
 
 
 
 
 
Alternatively, you could copy the HEIC file to your computer from your iPhone by plugging it 
in and syncing/copying your images or use Airdrop.  Process it with your editor of choice 
Lightroom CC, Lightroom, Photoshop, Affinity then follow the instructions for those as 
described in the sections above. 
 

Cleartrreeee
Outputting image for a PDI Competition

Image Size App

• Open in: Image Size App to resize for 

competitions

• Width and Height – 1600 x 1200

• Download to save to Camera Roll or email 

to yourself 

• Saves image in SRGB, 1600 x 1200

Cleartrreeee
Outputting image for a PDI Competition

• To correctly rename this jpg image for the 

BRCC competition uploader.  Select it in 
photos/camera roll

• Click on Save to Files

• Click in box to change file name

• (e.g. PDI – Landscapes; DOWN IN THE 
WOODS; myname.jpg)

• Save to Downloads

Cleartrreeee

Outputting image for a PDI Competition

• BRCC Competition File Uploader

• Browse, correctly sized and named image 

in Downloads folder

• Upload


